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Versão Alterações 

2.2  Abril de 2014 

P 1 e P 6: O plug-in TCC (Verificação da Integralidade Técnica) foi substituído 
pelo plug-in Assistente de Validação 

2.1  Novembro de 2012 

Documento atualizado, a fim de refletir as novas regras de negócio 
automatizadas na sequência da publicação da atualização do REACH-IT. A 
página Co-Registantes é a nova funcionalidade para a disponibilização de 
informações após a apresentação do pedido de informação. 

Alterações editoriais em todo o documento. 

2.0  Julho de 2012 

Documento atualizado, a fim de refletir as alterações introduzidas pela 
IUCLID 5.4 e informar os utilizadores sobre o plug-in Verificação da 
Integralidade Técnica (plug-in TCC), que pode agora ser utilizado para 
verificar um dossiê de consulta antes da sua apresentação à ECHA (P 7, 18 e 
49). 

P 8: Aditada uma clarificação sobre casos em que não é necessário um 
pedido de informação. 

1.4  Março de 2010 

Descrição do processo de apresentação do dossiê através do REACH-IT 2.0 e 
da IUCLID 5.2. 

1.3  Dezembro de 2009 

Pequenas reformulações da redação. 

P 8: Texto relativo a Entidades Jurídicas atualizado. 

Documento com nova configuração. 

1.2  Dezembro de 2008: 

P 34-35: Texto reformulado para explicar a forma de indicar que o pedido de 
informação é baseado no artigo 12.º, n.º 2. 

P 45: O texto passa a ter a seguinte redação: «Passo 5: No campo «Name» 
[Nome], escreva o nome da substância a que se refere o pedido de 
informação e, no campo «Dossier submission remark» [Observações relativas 
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à apresentação do dossiê], escreva «Inquiry dossier» [Dossiê de consulta]. 
Se o seu pedido de informação se dever a uma atualização do seu registo 
devido a um aumento da gama de tonelagem (artigo 12.º, n.º 2 do 
Regulamento EACH), escreva «Inquiry as a result of an update of a 
registration» [Pedido de informação na sequência de uma atualização de um 
registo] neste campo. Se a sua substância é uma substância de integração 
não progressiva colocada legalmente no mercado antes de junho de 2008 
(ver comunicado de imprensa da ECHA (ECHA/PR/08/12), de 9 de junho, 
disponível no sítio Web da ECHA), escreva «Inquiry dossier for non-phase-in 
substance legally on the market before June 2008» [Dossiê de consulta para 
uma substância de integração não progressiva colocada legalmente no 
mercado antes de junho de 2008] no campo «Dossier submission remark» 
[Observações relativas à apresentação do dossiê]. 

Neste campo, deve igualmente fornecer o motivo pelo qual essa colocação no 
mercado foi considerada legal.» 

P 50: Eliminação de texto relativo à apresentação através de procedimentos 
temporários. 
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1 Introdução 

O presente manual tem por objetivo ajudar a preparar um dossiê de consulta (pedido de 
informação) através da IUCLID 5. O manual assume que a IUCLID 5 foi instalada e que o 
utilizador possui uma conta, atribuída à entidade jurídica, criada durante a instalação da 
IUCLID 5. Se a IUCLID 5 ainda não estiver instalada, consulte o respetivo sítio Web, disponível 
em http://iuclid.echa.europa.eu/. Neste sítio Web, poderá transferir o software gratuitamente 
e encontrar orientações mais abrangentes sobre a utilização da IUCLID 5. 

O presente manual apresenta uma abordagem faseada à preparação e apresentação de um 
dossiê de consulta, conforme mostrado na Figura 1. 

Figura 1: Passos para a criação de um dossiê de consulta 

 

 Foi desenvolvida uma ferramenta de TI para fornecer apoio adicional sobre a 
forma de preparar um dossiê de consulta. Esta ferramenta designa-se 
«Substance Identity check» [Verificação da Identidade da Substância] e está 
disponível como funcionalidade no plug-in «Validation Assistant» [Assistente de 
Validação]. Este plug-in da IUCLID pode ser transferido através do sítio Web da 
IUCLID 5 (http://iuclid.echa.europa.eu/).  

A ferramenta ajuda a identificar os campos da IUCLID de um dossiê de 
consulta que devem ser preenchidos ou que merecem especial atenção. 
Recomenda-se a utilização do plug-in «Validation Assistant» no conjunto de 
dados da substância e no dossiê final antes da apresentação. Para obter mais 
informações sobre como utilizar o plug-in «Validation Assistant», deve 
consultar o «IUCLID 5 Technical Completeness Check Plug-in User Manual» 

http://iuclid.echa.europa.eu/
http://iuclid.echa.europa.eu/
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(Manual do utilizador do plug-in Verificação da Integralidade Técnica da IUCLID 
5) disponível com o plug-in «Validation Assistant» transferido. 

Antes de preparar um dossiê de consulta e apresentá-lo à ECHA, verifique se é necessário um 
pedido de informação: 

 É um potencial registante?  

Se a sua empresa fabrica ou importa pela primeira vez uma substância de 
integração progressiva em quantidades iguais ou superiores a uma tonelada por 
ano ou utiliza pela primeira vez uma substância de integração progressiva no 
contexto da produção de artigos ou importa pela primeira vez um artigo que 
contenha uma substância de integração progressiva que esteja sujeita a registo, 
após 1 de dezembro de 2008, pode utilizar a opção de pré-registo tardio prevista 
no artigo 28.º, n.º 6, do Regulamento REACH, em vez de apresentar um pedido de 
informação sobre a sua substância. 

Para beneficiar da opção de pré-registo tardio deve efetuar um pré-registo  

1) o mais tardar seis meses após o fabrico, a importação ou a utilização da 
substância exceder o limite de uma tonelada por ano e 

2) pelo menos 12 meses antes do fim do prazo de registo aplicável previsto no 
artigo 23.º do Regulamento REACH.  

As empresas que fabricam, importam ou produzem artigos (que contenham 
substâncias em quantidades inferiores a 100 toneladas por ano) devem apresentar 
o seu pré-registo tardio antes de 31 de maio de 2017. Entende-se por fabrico ou 
importação pela primeira vez o fabrico ou a importação pela primeira vez desde a 
entrada em vigor do Regulamento REACH. 

 
Tenha em atenção que, após o pré-registo de uma substância, não existe qualquer 
base jurídica para pedir informações sobre a mesma substância antes do registo. 
Nesses casos, o dossiê de consulta não será aceite para processamento. Por 
conseguinte, se já efetuou o pré-registo de uma substância (mas ainda não a 
registou), deve analisar os seus requisitos de informação e a disponibilidade de 
dados no Fórum de Intercâmbio de Informações sobre uma Substância (FIIS) 
criado para a sua substância.  

 Já é um registante? 

Nos termos do artigo 12.º, n.º 2, do Regulamento (CE) n.º 1907/2006 
(«Regulamento REACH»), um registante de uma substância que atinja o limite de 
tonelagem seguinte deve transmitir à ECHA as informações suplementares de que 
necessitará para atualizar o registo. Se não forem exigidas informações 
suplementares, não é necessário comunicar à ECHA a sua intenção de atualizar o 
registo para a gama de tonelagem seguinte e, consequentemente, apresentar um 
pedido de informação. Nesse caso, o dossiê de consulta não será aceite para 
processamento. 
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2 Entidades jurídicas 

Todas as informações criadas ou importadas numa instalação da IUCLID, por exemplo, um 
conjunto de dados da substância, são associadas a uma empresa/organização que é o 
proprietário do conjunto de dados. As informações que descrevem uma empresa/organização 
são mantidas num elemento específico da IUCLID, designado Entidade jurídica. Para 
apresentar um dossiê de consulta, deve ter uma entidade jurídica oficial. 

A criação de uma entidade jurídica oficial pode ser efetuada quer através do sítio Web oficial 
da IUCLID 5http://iuclid.echa.europa.eu/ quer diretamente no REACH-IT. Estão disponíveis 
informações sobre como criar uma entidade jurídica oficial no Manual de Utilização para a 
Indústria, do REACH-IT, Parte 2 – Inscrição e gestão de conta, disponível no sítio Web da 
ECHA (http://www.echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-
submission-industry-user-manuals). 

3 Criar e atualizar substâncias de referência 

Para identificar corretamente a substância sobre a qual pretende obter informações, é 
importante compreender o conceito de substância, de conjunto de dados da substância e de 
substância de referência na IUCLID 5. 

O dossiê de consulta é preparado para uma substância (definida nos termos do artigo 3.º, n.º 
1, do Regulamento REACH). 

Na IUCLID 5, o conjunto de dados da substância contém todas as informações relativas a uma 
substância específica (tais como a identidade da substância, os seus constituintes, a 
composição específica, etc.). 

Para criar o conjunto de dados da substância, deve utilizar substâncias de referência. A 
substância de referência permite-lhe armazenar num local centralizado informações de 
identificação relativas a uma dada substância ou a um dado constituinte de uma substância, 
tais como as denominações químicas (nome CE, nome CAS, nome IUPAC, sinónimos, etc.), os 
identificadores numéricos (por exemplo, número CE, número CAS) e as informações molecular 
e estrutural. O inventário de substâncias de referência é mantido diretamente por si, na sua 
instalação local, e poderá ser reutilizado noutros conjuntos de dados sem ser necessário 
reintroduzir as informações. 

Para aumentar o número de entradas no seu inventário de substâncias de referência, 
recomenda-se a transferência das cerca de 70 000 substâncias de referência pré-preenchidas a 
partir do sítio Web da IUCLID 5 e a sua importação para a sua instalação local (a menos que já 
o tenha feito durante a instalação da IUCLID 5). Estas substâncias de referência predefinidas 
foram preparadas para melhorar a qualidade dos dados e minimizar a introdução de dados. 

Além disso, deverá também transferir o inventário CE do sítio Web da IUCLID 5 (a menos que 
já o tenha feito durante a instalação da IUCLID 5). Este inventário é constituído por uma lista 
de identidades da substância baseada numa combinação dos seguintes inventários europeus: 
EINECS, ELINCS e lista de NLP («ex-polímeros»). Ao criar uma nova substância de referência 
com um número CE, deve primeiro extrair os dados do Inventário CE para minimizar a 
introdução de dados e assegurar a qualidade dos mesmos. 

Neste capítulo do manual, poderá encontrar o procedimento a seguir para pesquisar, atualizar 
e criar as substâncias de referência a atribuir à sua substância diretamente a partir do painel 
principal de tarefas.  

 Também é possível criar uma substância de referência diretamente a partir do 
conjunto de dados da substância (capítulo 5). 

http://iuclid.echa.europa.eu/
http://www.echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-submission-industry-user-manuals
http://www.echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-submission-industry-user-manuals
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3.1 Consultar e atualizar substâncias de referência 

Para começar, clique em «Update» [Atualizar] em «Reference substance» [Substância de 
referência] no painel principal de tarefas da IUCLID (Figura 2). 

Figura 2: Ligação Atualização na substância de referência 

 

Se, durante a instalação da IUCLID 5, optar por transferir e instalar o inventário de 
substâncias de referência, terá aproximadamente 70 000 substâncias de referência 
armazenadas no seu computador. Será apresentado um aviso a indicar que o limite predefinido 
da consulta é de 500 itens (Figura 3). 

Figura 3: Limite da consulta atingido  

 

Se responder «Yes» [Sim], a consulta de todas as substâncias de referência será ignorada na 
próxima vez que atualizar o inventário. 

Se responder «No» [Não], a IUCLID obterá a totalidade da lista de substâncias de referência 
na próxima vez que atualizar o inventário de substâncias de referência. De qualquer modo, 
será redirecionado para o ecrã «Reference substances» [Substâncias de referência] (Figura 4). 

No ecrã «Reference substance», clique em <Query> [Consulta].  

Figura 4: Botão Consulta 

 

É apresentada uma caixa de diálogo. Selecione a «Reference substance» [Substância de 
referência] em «Select query result type» [Selecionar o tipo de resultado da consulta] e 
selecione «Find Reference substances» [Localizar substâncias de referência] na lista pendente 
«Select query» [Selecionar consulta] (Figura 5). 
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Figura 5: Lista pendente da Consulta 

 

Introduza os critérios de pesquisa para a substância que está a procurar e clique em <Search> 
[Pesquisar]. Pode utilizar o asterisco (*) como caráter universal. 

Por exemplo, para obter todas as substâncias começadas por «fenol», escreva «fenol*». Para 
obter todas as substâncias terminadas em «amina», escreva «*amina». Para obter todas as 
substâncias que contêm «eth» no nome, escreva «*eth*» (Figura 6). 

 Os resultados de pesquisa não podem ser superiores a 2000, portanto a pesquisa 
deve ser suficientemente específica. 

Figura 6: Pesquisar uma substância de referência 

 

Uma vez encontrada a substância de referência, faça duplo clique na mesma para visualizar os 
dados associados (Figura 7). 
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Figura 7: Visualizar dados 

 

Analise os dados relativos à substância de referência. Para atualizar/adicionar quaisquer 
informações relativas à substância de referência, clique em <Edit item> [Editar item] (Figura 
7) na barra de ferramentas situada na parte superior do ecrã.  

Edite as informações sobre a substância de referência e guarde as alterações.  

 

3.2 Criar uma nova substância de referência 

Se não encontrar a sua substância de referência no Inventário de substâncias de referência, 
pode criá-la utilizando o procedimento seguinte. 

No ecrã principal, clique em «New» [Nova] em «Reference substance» [Substância de 
referência] (Figura 8). 

Figura 8: Ligação Nova na substância de referência 

 

Introduza o nome da substância de referência na janela de pop-up «Reference substance 
assistant» [Assistente da substância de referência]. Deve assinalar a caixa «Active Reference 
substance» [Substância de referência ativa], uma vez que apenas as substâncias de referência 
marcadas como «active» [ativa] podem ser utilizadas durante a criação de um conjunto de 
dados de uma substância (Figura 9). 
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Figura 9: Adicionar o nome da substância de referência 

  

A substância de referência é criada e é apresentada uma secção Substância de referência 
vazia.  

Se a substância de referência constar do Inventário CE, a entrada pertinente poderá ser 
atribuída clicando no botão de cadeia, conforme mostrado na Figura 10. 

Figura 10: Secção Substância de referência 

 

É apresentada a caixa de diálogo da consulta, onde é possível pesquisar as entradas do 
inventário CE (Figura 11): 

• Pesquise utilizando qualquer um dos critérios apresentados, por exemplo, o nome CE 
da substância. Também aqui pode utilizar «*» como caráter universal (Figura 11). 

• Clique na entrada que corresponde à sua substância de referência (a entrada é 
realçada). 

• Clique em «Assign» [Atribuir]. As informações disponíveis para esta substância de 
referência serão incluídas na sua nova substância de referência. 
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Figura 11: Pesquisar uma substância de referência 

 

 Se a sua substância de referência não constar do inventário CE, selecione uma 
justificação da lista pendente proposta na secção «No EC information available» 
[Nenhuma informação CE disponível]. 

 

Figura 12: Campo Justificação 

 

Preencha os campos, tanto quanto possível, para definir a sua substância de referência (ver 
exemplo na Figura 13).  

Deve indicar as seguintes informações:  
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• Número CE e nome CE (caso existam); 

• Número CAS e nome CAS (caso existam); 

• Nome IUPAC; 

• Descrição (especifique quaisquer informações adicionais relevantes para a descrição 
da substância de referência neste campo); 

• Fórmula molecular (se não for possível determinar uma fórmula molecular a partir da 
substância de referência, deve ser indicada uma justificação no campo «Remarks» 
[Observações] na parte inferior do ecrã); 

• Intervalo de massas moleculares (se aplicável); 

• Notação SMILES (se aplicável); 

• InChI (se aplicável); 

• Fórmula estrutural (se aplicável). 

Figura 13: Substância de referência preenchida 

 

Para incluir a fórmula estrutural, aceda a «Structural formula» [Fórmula estrutural] em 
«Molecular and structural information» [Informação molecular e estrutural] e clique em 
<Load> [Carregar]. Poderá então carregar um ficheiro de imagem com a fórmula estrutural 
(Figura 14). 

 Deve ser preparada uma substância de referência para a substância e para todos os 
constituintes (constituinte principal, impureza, aditivo) que a sua substância contém. 
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Figura 14: Carregar a fórmula estrutural 

 

4 Criar um conjunto de dados da substância 

Para criar um dossiê de consulta na IUCLID 5, é necessário criar primeiro um conjunto de 
dados da substância.  
Um conjunto de dados da substância é o repositório de dados que serve de base à criação do 
dossiê de consulta a apresentar à ECHA. 

Para criar um conjunto de dados da substância, deve clicar em «New» [Novo] no «Task Panel» 
[Painel de Tarefas] da IUCLID 5, em «Tasks» [Tarefas] (Figura 15). 

Figura 15: Ligação para criar um novo conjunto de dados da substância 

 

Introduza o nome da substância sobre a qual pretende obter informações. Pode optar por 
qualquer nome, mas deve utilizar um identificador com o qual esteja familiarizado (por 
exemplo, um nome comercial ou um nome químico) (Figura 16). 

Figura 16: Atribuir um nome à substância 

 

Clique em «Next» [Seguinte] e selecione a entidade jurídica a atribuir ao conjunto de dados da 
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substância  

(Figura 17). 

Figura 17: Atribuir uma entidade jurídica 

 

 Se a entidade jurídica a associar ao conjunto de dados da substância não estiver 
disponível na lista pendente, deverá ser atribuída uma nova entidade jurídica ao 
utilizador. Consulte as instruções fornecidas no sítio Web da IUCLID 5 e no Manual de 
Utilização para a Indústria, do REACH-IT, Parte 2 – Inscrição e gestão de conta, 
disponível no sítio Web da ECHA 
(http://www.echa.europa.eu/web/guest/support/dossier-submission-tools/reach-
it/data-submission-industry-user-manuals). 

Clique em <Finish> [Concluir]: criou um conjunto de dados da substância. 

A árvore de secções do conjunto de dados da substância é apresentada na área de navegação 
do ecrã (para uma vista completa da árvore, clique no botão de seta branca e selecione 
«Expand all» [Expandir tudo] no menu de pop-up) (Figura 18). 

Figura 18: Expandir a árvore de secções 

  

 A IUCLID 5 oferece a possibilidade de realçar as secções que são obrigatórias para 
tipos específicos de dossiê, a fim de ajudar o utilizador na preparação dos vários tipos 
de dossiês. No caso dos dossiês de consulta, selecione «REACH Inquiry» [Pedido de 
informação REACH] como tipo de dossiê. Para tal, clique no botão de seta preta e 
selecione «REACH Inquiry» na lista pendente. 
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Figura 19: Selecionar o modelo na lista pendente 

 

 Depois de selecionar «REACH Inquiry» [Pedido de informação REACH] como tipo de 
dossiê, as secções obrigatórias estão assinaladas a vermelho na IUCLID 5 e as 
opcionais são apresentadas a verde. 

 
4.1 Atribuir um representante terceiro 

Não é obrigatório indicar um representante terceiro. Contudo, se tiver sido designado um 
terceiro como representante (TPR) nos termos do artigo 4.º do Regulamento REACH, a 
entidade jurídica deste representante terceiro deve ser igualmente indicada no bloco 
«Substance identification» [Identificação da substância]. A fim de atribuir um TPR, deve obter 
junto do seu TPR o UUID da respetiva empresa (entidade jurídica oficial).  

Para obter mais informações sobre a criação e/ou importação de entidades jurídicas oficiais, 
consulte o sítio Web da IUCLID 5 e o Manual de Utilização para a Indústria, do REACH-IT, 
Parte 2 – Inscrição e gestão de conta, disponível no sítio Web da ECHA 
(http://www.echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-
submission-industry-user-manuals). 

Depois de obter o UUID (identificador universal único) da empresa do seu TPR na sua 
instalação local da IUCLID 5, este poderá ser atribuído ao conjunto de dados da substância. 
Clique no botão de cadeia junto ao TPR (Figura 20). É apresentada uma caixa de diálogo 
«consulta». Certifique-se de que as caixas de verificação «Official Legal entity» [Entidade 
Jurídica oficial] e «Show only active values» [Mostrar apenas valores ativos] estão assinaladas. 
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Figura 20: Consultar representantes terceiros 

 

Introduza os critérios de pesquisa e clique em <Search> [Pesquisar]. Pode utilizar o asterisco 
(*) como caráter universal. Clique no TPR que pretende atribuir ao seu conjunto de dados da 
substância (está realçado) e clique em <Assign> [Atribuir]: O TPR foi agora atribuído (Figura 
21). 

Figura 21: Atribuir um representante terceiro ao pedido de informação 
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5 Introduzir informações no conjunto de dados da 
substância 

Depois de criar o conjunto de dados da substância sobre a qual pretende obter informações, 
pode introduzir os dados relativos à substância neste conjunto de dados. As informações 
obrigatórias a incluir no conjunto de dados da substância estão descritas no artigo 26.º, n.º 1, 
do Regulamento REACH e no Guia de orientação sobre a partilha de dados disponível no sítio 
Web da ECHA (http://echa.europa.eu/web/guest/guidance-documents/guidance-on-reach). 

 Lembre-se de que estão disponíveis informações adicionais sobre a descrição de 
substâncias na IUCLID 5 no Guia de orientação para a identificação e designação de 
substâncias no âmbito dos Regulamentos REACH e CRE. Este guia de orientação está 
também disponível no sítio Web da ECHA (http://echa.europa.eu/web/guest/guidance-
documents/guidance-on-reach). 

Para obter o conjunto de dados da substância que criou, clique em «Update» [Atualizar] no 
menu «Substance» [Substância] no painel principal de tarefas e faça duplo clique na sua 
substância para a selecionar.  

 Para obter de forma mais fácil o conjunto de dados da substância, pode utilizar o 
sistema de filtragem, introduzindo a totalidade ou parte do nome da substância no 
campo de consulta, ou utilizar o sistema de consulta clicando em <Query> [Consulta]. 

Uma vez apresentada a substância no painel de introdução de dados (Figura 22), expanda a 
árvore de secções (clicando no separador «Section tree» [Árvore de secções]; ver Figura 18).  

Figura 22: Visualizar uma substância no campo da consulta  

 

Faça duplo clique em cada secção para visualizar a substância e clique em <Edit item> [Editar 
item] na parte superior do ecrã (Figura 23) para preencher os campos. 

Figura 23: Botão Editar na barra de ferramentas 

 

 

http://echa.europa.eu/web/guest/guidance-documents/guidance-on-reach
http://echa.europa.eu/web/guest/guidance-documents/guidance-on-reach
http://echa.europa.eu/web/guest/guidance-documents/guidance-on-reach
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5.1 Secção 1 – Informações gerais 

Deve fornecer informações (nas diversas secções da IUCLID) relativas à identificação da 
substância. 

5.1.1 Secção 1.1 - Identificação da substância 
Esta secção abrange a identidade da substância, a sua função na cadeia de abastecimento e as 
informações de contacto.  

5.1.1.1 Função na cadeia de abastecimento 
Assinale a caixa de verificação adequada para indicar a sua função na cadeia de abastecimento 
(Figura 24). 

Figura 24: Função na cadeia de abastecimento 

 

5.1.1.2 Substância de referência 
Em «Reference substance» [Substância de referência], clique no botão de cadeia para atribuir 
uma «Reference substance» à sua substância (Figura 25). 

Figura 25: Botão de cadeia 

 

É apresentada uma caixa de diálogo de consulta (Figura 26). Pesquise a sua «Reference 
substance» [Substância de referência]. Realce a substância de referência na lista de resultados 
e clique em <Assign> [Atribuir] (Figura 27). 
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Figura 26: Caixa de diálogo da Consulta 

 

Figura 27: Atribuir a substância de referência 
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Se não conseguir encontrar a sua substância de referência, tal significa que esta ainda não foi 
criada. Volte atrás para criar uma nova substância de referência, seguindo as instruções 
fornecidas no capítulo 3.2 ou os seguintes passos: 

• Clique em «New» [Nova] para criar uma nova substância de referência (Figura 28). 

• Será redirecionado para o «Reference substance assistant» [Assistente da substância 
de referência]. 

Introduza o nome da substância de referência que pretende criar e clique no botão «Finish» 
[Concluir] (Figura 29). 

Para especificar as informações relativas à nova substância de referência, clique no botão de 
seta azul (Figura 30). 

• Será redirecionado para o ecrã relativo à nova substância de referência. Preencha 
todos os campos possíveis conforme descrito no capítulo 3 – Criar e atualizar 
substâncias de referência. 

• Clique em <Save> [Guardar]. 

• Clique no botão de seta de retrocesso ( ) para voltar à substância (guarde quando 
solicitado). 

Figura 28: Botão para criar uma nova substância de referência 

 

 É possível que a substância de referência já exista, mas não esteja definida como 
«Active» [Ativa]. Neste caso, desmarque a caixa de verificação «Show only active 
values» [Mostrar apenas valores ativos] para visualizar as substâncias de referência 
marcadas como ativas e inativas. Clique com o botão direito do rato na substância de 
referência não ativada que pretende atribuir e clique em «Active reference substance» 
[Substância de referência ativa] para ativar a substância. Em seguida, clique em 
<Assign> [Atribuir]. 
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Figura 29: Nome da substância de referência 

 

Figura 30: Botão de seta azul 

 

Preencha manualmente todos os campos relativos à substância de referência (novamente, 
preencha o máximo de campos possível). 

5.1.1.3 Tipo de substância 
As informações relativas ao tipo de substância podem ser incluídas clicando nos botões de seta 
para baixo ( ) junto a «Composition» [Composição] e «Origin» [Origem] e selecionando o item 
relevante nas listas pendentes (Figura 31 e Figura 32).  

 

Figura 31: Composição de uma substância 
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Figura 32: Origem de uma substância 

 

Além disso, o botão «Add» [Adicionar] ( ) por baixo de «other names» [outros nomes] 
permite criar blocos de repetição adicionais, caso pretenda adicionar nomes alternativos ou 
nomes comerciais para a sua substância. 
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5.1.1.4 Pessoa de contacto 
Embora as informações de contacto da sua empresa sejam especificadas no campo «Legal 
entity» [Entidade jurídica], também pode indicar as informações da pessoa de contacto para 
essa substância específica. Preencha o máximo de campos possível (Figura 33). 

Figura 33: Campos de informações de contacto 

 

 

5.1.2 Secção 1.2 – Composição 
A fim de incluir informações relativas à composição da substância, faça duplo clique na secção 
«1.2 Composition» [1.2 Composição] e clique em <Edit item> [Editar item] (Figura 23). Clique 
no botão de cruz verde «Add» [Adicionar] (Figura 37).  

Introduza o nome e uma breve descrição da sua substância (Figura 34). 
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Figura 34: Nome da substância 

 

Preencha a secção «Degree of purity» [Grau de pureza]. O grau de pureza a especificar deve 
corresponder à concentração dos principais constituintes da sua substância. A lista pendente 
permite escolher símbolos ou unidades numa lista de opções e as caixas permitem introduzir 
números. Nesta parte, indicar o intervalo de pureza típica para a substância (Figura 35). 

Figura 35: Grau de pureza 

 

Para incluir os constituintes, clique no botão <Add> [Adicionar] conforme mostrado na Figura 
37. Atribua uma «Reference substance» [Substância de referência] a cada constituinte, 
clicando no botão de cadeia (Figura 25). Pesquise a substância de referência adequada 
(conforme descrito no capítulo 5.1.1.2) e clique em <Assign> [Atribuir] para a selecionar e 
adicionar. Se a substância de referência ainda não existir, crie uma nova (tal como descrito no 
capítulo 3.2).  

Indique a concentração típica e o intervalo de concentração (valores mínimos e máximos) para 
cada constituinte (Figura 39) de forma idêntica à indicada acima para o grau de pureza. 
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Figura 36: Concentrações típicas para cada constituinte 

 
Se for necessário especificar vários constituintes, clique em <Add> [Adicionar] (Figura 37) na 
secção pertinente e será apresentado um novo bloco de repetição. 

Figura 37: Botão de cruz verde para caixas adicionais 

 
Siga o mesmo procedimento para preencher as informações respeitantes aos campos relativos 
a impurezas e aditivos (Figura 38). 
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Figura 38: Caixas adicionais para as impurezas e os aditivos  

 

5.1.3 Secção 1.3 – Identificadores 
Na presente secção, se aplicável, é possível adicionar identificadores relativos a outros 
programas de regulamentação ou sistemas de TI. Em especial, indique o seu número PPORD 
se a substância tiver sido anteriormente objeto de uma notificação de investigação e 
desenvolvimento orientados para produtos e processos (PPORD). Se estiver a apresentar um 
pedido de informação com base no artigo 12.º, n.º 2, do Regulamento REACH, deve indicar 
nesta secção o seu número de registo e (se pertinente) o número da notificação.  

Faça duplo clique em «1.3 Identifiers» [1.3 Identificadores] na árvore de secções para abrir a 
secção 1.3 do conjunto de dados da substância da IUCLID 5 e, em seguida, clique em <Edit 
item> [Editar item] (Figura 39).  

Figura 39: Abrir a secção 1.3 na IUCLID 

 

Em «Regulatory programme identifiers» [Identificadores de programa de regulamentação], 
selecione «Add» [Adicionar] para editar a lista de identificadores. É apresentada no ecrã uma 
janela de pop-up com o título «Regulatory programme identifier» [Identificador de programa 
de regulamentação] (Figura 40). 
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Figura 40: Janela de pop-up 

 

Primeiro selecione na lista pendente a opção pertinente («REACH PPORD notification number» 
[Número de notificação PPORD do REACH] ou «notification number (NCD)» [Número de 
notificação (NCD)] ou «REACH registration number» [Número de registo REACH]) e depois 
introduza o número relevante no campo «ID».  

Para visualizar os identificadores de regulamentação numa lista, clique em <OK> na janela 
«Regulatory programme identifier» [Identificador de programa de regulamentação]. 

5.1.4 Secção 1.4 – Informação analítica 
Na árvore de secções do conjunto de dados da substância, faça duplo clique na secção «1.4 
Analytical information» [1.4 Informação analítica] e, em seguida, clique no botão <Edit item> 
[Editar item] (Figura 23). 

No campo «Analytical methods and spectral data» [Métodos analíticos e dados espetrais], 
descreva os métodos analíticos utilizados para caracterizar a substância e, se aplicável, as 
impurezas e os aditivos. Também pode anexar essas informações, clicando no botão de clipe 
( ). 

 Apenas pode anexar um ficheiro em cada campo. 

No campo «Optical activity» [Atividade ótica], forneça informações sobre a atividade ótica e o 
rácio típico de (estereo) isómeros, se aplicável (Figura 41). 

Figura 41: Introduzir os métodos analíticos e os dados espetrais 

 

Os resultados analíticos utilizados para caracterizar a substância, tais como dados espetrais 
(UV, IR, NMR, MS, etc.), dados cromatográficos, etc., são apresentados em «Results of 
analysis» [Resultados da análise]. 
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Para cada resultado analítico, clique no botão de cruz verde para adicionar um novo bloco de 
repetição (conforme mostrado na Figura 37) e introduza o tipo de análise, a substância de 
ensaio, o método utilizado e eventuais observações que considere pertinentes. Para cada 
análise, deve anexar um ficheiro que contenha o(s) resultado(s) desta análise, clicando no 
botão de clipe (Figura 42). 

Figura 42: Introduzir resultados de análise 

 

 Se não for adicionado qualquer anexo nesta secção, o dossiê não será aceite para 
processamento. 

 
5.2 Secção 3 – Fabrico, utilização e exposição 

Deve fornecer informações nas secções da IUCLID relativas ao fabrico, à utilização e à 
exposição da sua substância. 

5.2.1 Secção 3.3 – Instalações 
Utilize esta secção para indicar a instalação (Site) onde decorre a produção ou a utilização 
da sua substância. Quando necessário, deve criar essas instalações na secção pertinente do 
painel principal de tarefas. 

5.2.1.1 Criar uma instalação 
No painel principal de tarefas, clique em «New» [Nova] em «Legal entity site» [Instalação da 
entidade jurídica]. No «Site assistant» [Assistente de instalações] apresentado, introduza o 
nome da sua instalação (Figura 43). 

Figura 43: Introduzir o nome de uma instalação 
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Atribua a entidade jurídica do proprietário à instalação e clique em <Finish> [Concluir] (Figura 
44). 

Figura 44: Atribuir a entidade jurídica 

 

É apresentado o ecrã «Legal entity» [Entidade jurídica]. Indique o endereço da sua instalação, 
bem como as informações de contacto e outros identificadores de TI (Figura 45). 

Figura 45: Ecrã Entidade jurídica com informações de contacto 

 

Clique em <Save> [Guardar]: criou uma instalação que pode ser associada ao conjunto de 
dados da substância. 

5.2.1.2 Atribuir uma instalação 
Na árvore de secções do conjunto de dados da substância, faça duplo clique na secção «3.3 
Sites» [3.3 Instalações] e, em seguida, clique em «Edit item» [Editar item] (conforme 
mostrado na Figura 23). Clique no botão de cruz verde para criar um novo bloco de repetição 
(conforme mostrado na Figura 37). São apresentados os campos onde podem ser 
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especificadas as informações relativas à instalação de produção/utilização. Clique no botão de 
cadeia (conforme mostrado na Figura 25) para associar as instalações atribuídas à sua 
entidade jurídica. Selecione a instalação e clique em <OK> (Figura 46). 

Figura 46: Associar a instalação à entidade jurídica 
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5.3 Secção 14 – Requisitos de informação  

Deve indicar quais os requisitos de informação que lhe poderão ser aplicáveis. 

5.3.1   Novo registo de estudo de parâmetros 
Clique na secção «14.1 Inquiry» [14.1 Pedido de informação] para criar um «New endpoint 
study record» [Novo registo de estudos de parâmetros] (Figura 47). 

Figura 47: Adicionar um novo registo de estudo de parâmetros 

 

É apresentada a secção «New endpoint study record» [Novo registo de estudo de parâmetros]. 
Altere o nome deste novo registo de estudo de parâmetros para «Request for Information» 
[Pedido de informação] (Figura 48) e clique no botão «OK». 

Figura 48: Nome para o registo de estudo de parâmetros 
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5.3.2   Selecionar o tipo de pedido de informação 
Na lista pendente por baixo de «Type of Inquiry» [Tipo de pedido de informação] (Figura 49), 
selecione primeiro o tipo de pedido e os requisitos de informação que exigiriam a realização de 
novos estudos. 

Figura 49: Selecionar o tipo de pedido de informação 

 

Estão disponíveis para seleção quatro tipos de pedido de informação.  

Tipo 1 – Pedido de informação para substâncias de integração não progressiva 

Este pedido de informação destina-se a uma substância de integração não progressiva, em 
conformidade com o artigo 26.º do Regulamento REACH, não abrangida por nenhum dos 
outros tipos de pedido de informação. 

Tipo 2 – Pedido de informação para substâncias de integração não progressiva colocadas 
legalmente no mercado antes de junho de 2008 

Este pedido de informação destina-se a uma substância de integração não progressiva em 
conformidade com o artigo 26.º do Regulamento REACH, sempre que a substância tiver sido 
colocada no mercado antes de junho de 2008 (ver comunicado de imprensa ECHA/PR/08/12, 
de 9 de junho de 2008, disponível no sítio Web da ECHA em 
http://echa.europa.eu/web/guest/news-and-events/news-alerts). 

 Se selecionar «Type 2» [Tipo 2], deve fornecer a justificação do motivo pelo qual a 
colocação no mercado foi considerada legal (Figura 50) 

Figura 50: Pedidos de informação de Tipo 2 

 

Tipo 3 – Pedido de informação para substâncias de integração progressiva que não foram 
pré-registadas 

Pedido de informação para uma substância de integração progressiva (que não foi 
pré-registada), em conformidade com o artigo 26.º do Regulamento REACH, não abrangida por 
nenhum dos outros tipos de pedido de informação. 

http://echa.europa.eu/web/guest/news-and-events/news-alerts
http://echa.europa.eu/web/guest/news-and-events/news-alerts
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 Se já registou a substância para a qual está a solicitar informações e selecionar «Type 
1», «Type 2» ou «Type 3», o seu pedido de informação não será aceite para 
processamento.  

Tipo 4 – Pedido de informação para efeitos de aumento da gama de tonelagem 

Antes de apresentar uma atualização do seu registo, devido a um aumento da gama de 
tonelagem, deve comunicar à ECHA as informações suplementares de que necessita para 
cumprir os requisitos de informação relativos à nova gama de tonelagem (artigo 12.º, n.º 2). 
Deve selecionar este tipo de pedido de informação, a fim de cumprir as suas obrigações nos 
termos do artigo 12.º, n.º 2, do Regulamento REACH. 

Figura 51: Pedidos de informação de tipo 4 

 

 Se selecionar «Type 4» [Tipo 4], deve selecionar a gama de tonelagem a que se refere o 
seu pedido de informação (Figura 51). 

 Se ainda não registou a substância para a qual está a solicitar informações e selecionar 
«Type 4» [Tipo 4] como o tipo de pedido de informação, o seu pedido não será aceite 
para processamento.  

 Se não forem solicitadas informações suplementares, não existe qualquer motivo para 
apresentar um pedido de informação à ECHA. Não serão aceites para processamento os 
pedidos de informação de tipo 4 para os quais não foram solicitadas informações 
suplementares. 

 
5.3.3 Especificar os requisitos de informação 
Em «Information requirements» [Requisitos de informação], indique se deve cumprir requisitos 
de informação que exigiriam a realização de novos estudos. Selecione «yes» [sim] ou «no» 
[não] na lista pendente apresentada (Figura 52). 

Tenha em atenção que as secções «Information requirements» [Requisitos de informação] e 
«New studies to be conducted» [Novos estudos exigidos] devem ser preenchidas de uma 
forma coerente. 

Os dossiês preenchidos de forma incoerente não serão aceites para processamento. 
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Figura 52: Especificar os requisitos de informação 

 

Se selecionar «yes» [sim] em «Information requirements» [Requisitos de informação], deve 
especificar os seus requisitos de informação selecionando «yes» para um ou mais parâmetros 
relevantes indicados na secção «New studies to be conducted» [Novos estudos exigidos] e em 
«Physico-chemical properties» [Propriedades físico-químicas], «Toxicological information» 
[Informação toxicológica], «Ecotoxicological information» [Informação ecotoxicológica] e 
«Methods of detection and analysis» [Métodos de deteção e análise].  

Se não tem de cumprir requisitos de informação, selecione «no» [não] em «Information 
requirements» [Requisitos de informação] e não preencha os campos «Physico-chemical 
properties» [Propriedades físico-químicas], «Toxicological information» [Informação 
toxicológica], «Ecotoxicological information» [Informação ecotoxicológica] e «Methods of 
detection and analysis» [Métodos de deteção e análise].  

Figura 53: Selecionar os parâmetros relevantes 

 

 Se tiver registado uma substância em conformidade com o artigo 10.º e solicitar 
informações suplementares em conformidade com o artigo 12.º, n.º 2, a ECHA processará 
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o seu pedido, desde que este não abranja parâmetros já apresentados no seu dossiê de 
registo. 

A lista de parâmetros que lhe será fornecida (se disponível) seguirá os critérios descritos 
abaixo: 

Gama de tonelagem 
do registo existente 

1 a 10 tpa 10 a 100 tpa 100 a 1 000 tpa > 1000 tpa 

As informações 
obrigatórias incluídas 
no registo existente * 

Anexo VII Anexos  
VII, VIII 

Anexos  
VII, VIII, IX 

Anexos  
VII, VIII, IX, X 

As informações devem 
ser apresentadas, se 
forem solicitadas e 
estiverem disponíveis  

Anexos 
 VIII, IX, X 

Anexos 
IX, X 

Anexo 
X 

Este pedido de 
informação não 
será aceite para 
processamento 

* Por esse motivo, as informações podem não ser solicitadas. 

Os critérios acima descritos não se aplicam se o seu dossiê atual se destinar ao registo de uma 
substância intermédia isolada transportada ou a uma notificação nos termos da Diretiva 
67/548/CEE, que não tenha sido ainda atualizada devido a um aumento da gama de 
tonelagem nos termos do artigo 24.º, n.º 2, do Regulamento REACH, ou seja, todos os pedidos 
serão tidos em conta. 

5.4 Anexar ficheiros como informação adicional 

Se pretender anexar ficheiros com informações adicionais, poderá fazê-lo através da janela 
«Information» [Informação] localizada na parte inferior do ecrã do conjunto de dados da 
substância (Figura 54). Esta janela está minimizada por predefinição e pode ser utilizada 
clicando no botão direito para maximizá-la.  

Figura 54: Maximizar a janela de informação 

 

É apresentado o ecrã de informação. Clique no separador «Attachments» [Anexos] (Figura 
55). 

Figura 55: Ecrã de informação com o separador de anexos 

 

Para adicionar um anexo, clique no botão <Edit item> [Editar item], clique com o botão direito 
do rato no campo branco à esquerda e selecione <Add> [Adicionar] (Figura 56). 
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Figura 56: Anexar um documento através do botão adicionar 

 

O sistema perguntará se pretende guardar o documento de trabalho. Clique em <Accept> 
[Aceitar] e será apresentada a caixa de pesquisa. Selecione o ficheiro a anexar e clique em 
<Open> [Abrir] (Figura 57). 

Figura 57: Caixa de pesquisa com o ficheiro selecionado para anexar 

 

Introduza eventuais observações sobre o ficheiro e clique em <Save> [Guardar]. O ficheiro 
anexado será apresentado na lista (Figura 58). 

Figura 58: Lista de documentos anexados 

 

Se pretender anexar mais do que um ficheiro, repita os passos anteriores (Figura 59). 
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Figura 59: Documentos adicionais anexados 

  

Depois de adicionar todos os anexos necessários ao conjunto de dados da substância, clique no 
botão <Minimise> [Minimizar] para visualizar o painel de introdução de dados do conjunto de 
dados da substância (Figura 60). 

Figura 60: Botão Minimizar 

 

 

6 Criar um dossiê de consulta 

No painel de tarefas da IUCLID 5, selecione «Update» [Atualizar] em «Substance» 
[Substância]. São apresentadas todas as substâncias disponíveis e pode selecionar a 
substância para a qual pretende criar o dossiê de consulta. Clique com o botão direito do rato 
numa substância da lista de resultados da consulta e, no menu de pop-up, selecione «Create 
Dossier» [Criar Dossiê] (Figura 61). 

Figura 61: Selecionar a opção criar dossiê no menu de pop-up 

 

É apresentado o assistente de criação de dossiês. Siga os 8 passos do assistente para criar o 
dossiê de consulta. 
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Passo 1: Selecione o modelo de dossiê «REACH Inquiry» [Pedido de informação] (Figura 62). 
Clique em <Next> [Seguinte]. 

 Recomendamos vivamente que execute o plug-in «Validation Assistant» [Assistente de 
Validação] no seu dossiê antes de o apresentar à ECHA. O plug-in «Validation 
Assistant» [Assistente de Validação] identificará os campos do seu dossiê de consulta 
que devem ser objeto de especial atenção. Recomendamos ainda que corrija qualquer 
falha ou mensagem de aviso relevante apresentadas pela ferramenta. Caso contrário, o 
seu dossiê de consulta poderá não ser aceite para processamento nem receber um 
número. 

Figura 62: Selecionar o modelo do dossiê 
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Passo 2: Clique nos dois botões <Select all> [Selecionar todos] para selecionar todos os 
sinalizadores de Confidencialidade e de Fins de regulamentação ou desmarque as caixas de 
verificação das propriedades cujos registos de estudos não serão incluídos no dossiê (Figura 
63). Clique em <Next> [Seguinte]. 

Figura 63: Selecionar sinalizadores de confidencialidade e de fins de regulamentação 
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Passo 3: Selecione os dados a incluir no dossiê de consulta (Figura 64). Clique em <Next> 
[Seguinte] caso se apliquem as predefinições (ou seja, todas as subsecções selecionadas das 
secções 1-3). Sempre que se apliquem definições diferentes, selecione/desmarque conforme 
necessário e clique em <Next> [Seguinte]. 

Tenha em atenção que as caixas de verificação assinaladas a preto não podem ser 
desmarcadas.  

Figura 64: Incluir dados no dossiê 
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Passo 4: Caso se apliquem as predefinições, clique em <Next> [Seguinte] (Figura 65). Para 
especificar o nível de pormenor a incluir no dossiê, selecione outra caixa de verificação e clique 
em <Next> [Seguinte]. 

Figura 65: Inclusão do nível de pormenor no dossiê 

 

 

Passo 5: Verifique os documentos selecionados (Figura 66) e clique em <Next> [Seguinte]. 

Figura 66: Seleção de documentos 

 

 

Passo 7: Introduza dados administrativos adicionais (Figura 67). 

No campo «Name» [Nome], introduza o nome da substância a que se refere o pedido de 
informações e, no campo «Dossier submission remark» [Observações relativas à apresentação 
do dossiê], escreva «Inquiry dossier» [Dossiê de consulta] e clique em «Next» [Seguinte]. 
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Figura 67: Introdução de dados administrativos 

 

Se está a apresentar um pedido de informação devido a um aumento da gama de tonelagem 
(artigo 12.º, n.º 2, do Regulamento REACH), deve escrever «Inquiry as a result of an update 
of a registration» [Pedido de informação em virtude de um aumento da gama de tonelagem], 
no campo «Dossier submission remark» [Observações relativas à apresentação do dossiê]. 

Se a sua substância é uma substância de integração não progressiva colocada legalmente no 
mercado antes de junho de 2008 (ver comunicado de imprensa da ECHA (ECHA/PR/08/12), de 
9 de junho, disponível no sítio Web da ECHA em http://echa.europa.eu/web/guest/news-and-
events/news-alerts), escreva «Inquiry dossier for non-phase-in substance legally on the 
market before June 2008» [Dossiê de consulta para uma substância de integração não 
progressiva colocada legalmente no mercado antes de junho de 2008] no campo «Dossier 
submission remark» [Observações relativas à apresentação do dossiê]. Neste campo, deve 
igualmente fornecer uma justificação do motivo pelo qual essa colocação no mercado foi 
considerada legal. 

 

http://echa.europa.eu/web/guest/news-and-events/news-alerts
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Passo 8: Decida a definição da proteção da propriedade (Figura 68). 

Figura 68: Definições de proteção de propriedade 

 

Clique em <Finish> [Concluir] na janela de definições da proteção de propriedade. 

É apresentada uma janela que o informa se a criação do dossiê foi bem-sucedida (Figura 69). 

Figura 69: Mensagem final da criação do dossiê 

 

Pode <Close wizard> [Fechar o assistente] ou <View dossier> [Visualizar o dossiê]. O dossiê 
será apresentado se clicar no botão «View dossier» [Visualizar o dossiê]. 

 

7 Exportar um dossiê de consulta 

Para enviar o dossiê de consulta à ECHA, deve exportá-lo e guardá-lo no seu computador. No 
painel de tarefas principal, clique no ícone de dossiê ou na ligação «View» [Visualizar] (Figura 
70). 
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Figura 70: Visualizar um dossiê 

 

Selecione o seu dossiê de consulta, clique no mesmo com o botão direito do rato e selecione 
«Export» [Exportar] (Figura 71). 

Figura 71: Exportar um dossiê 

 

Selecione «Export without annotations» [Exportar sem anotações] (exceto se tiver incluído 
informações pertinentes como, por exemplo, anotações no dossiê) e clique em <Next> 
[Seguinte] (Figura 72). 
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Figura 72: Seleção das anotações na exportação 

 

No passo seguinte, clique no botão Guardar para especificar a localização onde pretende 
guardar o dossiê (Figura 73). 

Figura 73: Botão Guardar e localização 

 

Clique em <Finish> [Concluir]. O dossiê foi exportado para a localização especificada.  
Será apresentada uma mensagem de confirmação (Figura 74). 
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Figura 74: Relatório de progresso da exportação 

 

 

8 Atualizar um dossiê 

Este capítulo fornece informações sobre como atualizar as informações contidas no seu dossiê. 

Se for necessário enviar informações suplementares sobre o dossiê de consulta, quer seja em 
resultado de informações incompletas, falta de qualidade ou incapacidade para verificar a 
identificação da substância, não é necessário reintroduzir todos os dados relativos à 
substância. 

No painel de tarefas principal, clique em «Update» [Atualizar] por baixo de «Substance» 
[Substância] (Figura 75). 

Figura 75: Seleção de uma ligação de atualização 

 

Na lista, selecione e faça duplo clique na substância para a qual pretende enviar novas 
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informações. Na vista de árvore do conjunto de dados da substância, selecione a(s) 
secção(ões) que pretende atualizar. Pode sempre editar as secções necessárias clicando em 
<Edit item> [Editar item] (Figura 23).  

Para criar e exportar o dossiê, consulte os capítulos 6 e 7 do presente manual. 

 

9 Apresentar um dossiê de consulta 

O presente capítulo contém informações sobre o envio de um dossiê de consulta à ECHA. Em 
primeiro lugar, deve registar a sua entidade jurídica no REACH-IT. 

9.1 Passo 1 – Registo da empresa no REACH-IT 

Se não possui uma conta no REACH-IT, consulte o Manual de Utilização para a Indústria, do 
REACH-IT, Parte 2 – Inscrição e gestão de conta, disponível em 
http://echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-submission-
industry-user-manuals) ou siga as instruções indicadas a seguir: 

• Aceda ao sítio Web da ECHA (http://echa.europa.eu/) para aceder ao REACH-IT ou 
aceda diretamente ao sítio Web do REACH-IT 
(http://echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-
submission-industry-user-manuals). 

• No REACH-IT, clique em «sign-up as a company» [registar como empresa] (Figura 76). 

Figura 76: Página inicial do REACH-IT 

 

• Na página seguinte, deverá aceitar os termos e condições para prosseguir com o 
processo de registo. Se concordar com os termos e condições, clique em <Accept> 
[aceitar] (Figura 77). 

http://echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-submission-industry-user-manuals
http://echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-submission-industry-user-manuals
http://echa.europa.eu/
http://echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-submission-industry-user-manuals
http://echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-submission-industry-user-manuals
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Figura 77: Registo no REACH-IT 

 

Siga o procedimento de registo.  

 

Será orientado ao longo dos cinco passos seguintes: 

• Conta de utilizador – Crie a sua conta de utilizador do REACH-IT. 

• Informação da empresa – Forneça informações gerais sobre a sua empresa. Por 
motivos de coerência, deve importar o objeto da entidade jurídica (LEO), criado no 
sítio Web da IUCLID 5, associado à substância para a qual foi criado o dossiê de 
consulta da IUCLID 5 (ver também o Manual de Utilização para a Indústria do 
REACH-IT – Partes 1 e 2, http://www.echa.europa.eu/web/guest/support/dossier-
submission-tools/reach-it/data-submission-industry-user-manuals). 

• Informação de faturação – Forneça as informações de faturação da sua empresa. 

• Contactos – Neste ecrã, pode especificar as pessoas de contacto da sua empresa. 

• Validação – Confirme as informações que forneceu e modifique-as, se necessário. 

 

9.2 Passo 2 – Apresentar um dossiê de consulta da IUCLID 5 

Consulte o Manual de Utilização para a Indústria, do REACH-IT, Parte 6 – Apresentação do 
dossiê, disponível em http://www.echa.europa.eu/web/guest/support/dossier-submission-
tools/reach-it/data-submission-industry-user-manuals 

 

http://www.echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-submission-industry-user-manuals
http://www.echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-submission-industry-user-manuals
http://www.echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-submission-industry-user-manuals
http://www.echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-submission-industry-user-manuals
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9.3 Passo 3 – Receber o resultado de um dossiê de consulta 

Consulte o Manual de Utilização para a Indústria, do REACH-IT, Parte 11 – Criação e 
apresentação de dossiês de consulta em linha (capítulo 4) disponível em 
http://www.echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-
submission-industry-user-manuals. 

 

http://www.echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-submission-industry-user-manuals
http://www.echa.europa.eu/web/guest/support/dossier-submission-tools/reach-it/data-submission-industry-user-manuals
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